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WARNING!
THE DEVICE CONTAINS STRONG MAGNETS . THESE 
MAGNETS CAN ATTRACT METALLIC FERROMAGNETIC 
OBJECTS ABRUPTLY AND UNEXPECTEDLY . THE 
ATTRACTED OBJECT MAY HIT THE DEVICE AND CAUSE 
DEVICE DAMAGE . DO NOT BRING OBJECTS MADE OF 
FERROMAGNETIC MATERIALS CLOSE TO THE DEVICE 
(E .G . TWEEZERS, SCREWDRIVERS, SCISSORS, KEYS, 
COINS, DRAWING PINS AND CLIPS, ETC .)

FUNCTION
Magneto-optical visualizer (hereinafter referred to as 

the «visualizer») Regula 4197 is intended for expert examination of 
document magnetic protection.

The device visualizes images executed with magnetic inks, tapes, 
fibers and other magnetic materials. The visualized images are 
displayed on a PC monitor and can be stored as files of normal raster 
graphic formats.

The visualizer allows assessing values of certain magnetic 
parameters of document magnetic protection elements. The results 
are presented in graphical and numerical form, and can be saved for 
later playback and analysis.

The visualizer delivery set includes specialized software that allows 
an expert to carry out digital postprocessing of scanned images for 
the purpose of their analysis, comparison, assessment of geometric 
parameters and sizes, improvement of legibility and clearness.

AREAS OF APPLICATION
Regula 4197 visualizer can be used in:

  Forensics: authenticity verification of securities, banknotes; 
classification of document and banknote forgery methods; 
examination of damaged documents (reading of stained 
texts printed in magnetic ink);
  Production of securities, banknotes, forms: quality 
control of magnetic protection elements; investigation of 
magnetic printing techniques and materials; 
  Banking: authenticity verification of securities, banknotes;
  Authenticity verification of banknotes at customs.

1
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DEVICE DESIGN
Visualizer Regula 4197 consists of the following components 

(Figure 1): an optical electronic block 1 and a magnetic excitation 
system 2. The right 3 and left 4 functional buttons and a LED 
indicator 5 are located on the top of the optical electronic block. 
The sensitive element (magneto-optical crystal) 6 (Figure 2) is located 
on the bottom surface of the optical electronic block. The magnetic 
excitation system is removable. There are grooves 7 (Figure 3) 
intended for positioning the magnetic excitation system on the optical 
electronic block. The visualizer is connected to a PC via a USB cable 
located on the back of the device. There can be two versions of 
the visualizer with one (A) or two (B) USB plugs. In case (B) both 
plugs should be connected to the computer sockets .

3

Figure 1

Figure 2
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Figure 3

DELIVERY SET
The delivery set includes:

  Magneto-optical visualizer Regula 4197
  Visualizer pad
  Special software
  User’s guide
  Test object

DESCRIPTION OF DEVICE OPERATION
The magneto-optical visualizer Regula 4197 is a USB device. 

Its power supply, control, output and processing of examination 
results are carried out with the help of a PC. The visualizer is to be 
connected to one of PC USB-ports.

The visualizer sensitive element (magneto-optical crystal) senses 
the magnetic field of a magnetic protection element in a questioned 
document. The sensitive element state is converted into a digital image 
with the help of the optical system and the digital camera, which are 

4
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located inside the device. After special preliminary processing, the 
image is output to the CADR application window.

Near the sensitive element there is an inductor. In certain visualizer 
operation modes, it generates series of magnetic impulses affecting 
the sensitive element. The inductor is intended to increase sensitivity 
of the visualizer, improve image quality and to generate magnetic 
displacement fields used in the mode assessing magnetic parameters 
of document security features.

The magnetic excitation system of the device is a source of external 
magnetic field for magnetization of magnetically hard materials and 
for magnetic excitation of magnetically soft materials used to produce 
magnetic protection elements.

There are two types of materials used to produce document 
security features with magnetic properties: magnetically hard and 
magnetically soft.

Magnetically hard materials obtain their own magnetic field 
after they are magnetized by an external magnetic field. The sensitive 
element responds to the magnetic field obtained by magnetically 
hard materials.

Magnetically soft materials do not retain their own magnetic 
field after the source of external magnetic field is removed. But if 
they are kept in the magnetic field created by an external source, 
these materials cause distortions of the field. Such distortions are 
detected by the device sensitive element.

The magnetic excitation system enables to distinguish security 
features made of different types of magnetic materials: the images 
made of magnetically soft materials are visible only if the magnetic 
excitation system is installed. The images made of magnetically 
hard materials, once magnetized, are visible both with the installed 
magnetic excitation system and without it. Some insignificant 
differences in the image brightness and contrast are possible.

The CADR software is intended for continuous displaying of the 
visualized magnetic image on a PC monitor and for storing separate 
image frames at the operator’s choice. In addition, the CADR 
application provides a wide range of tools for digital image processing. 
The software is included in the visualizer delivery set.

OPERATION ORDER

Preparing for operation
Before the device is switched on for the first time:
– Make sure the device does not have any visible defects or 

damages.

6
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If you notice any defects or damages, contact your supplier.
– Place the visualizer pad on a flat surface. Observe the requirements 

for the surface and for the surroundings of the workplace in which the 
visualizer will be used.

1) Objects made of ferromagnetic materials (materials which 
attract magnets) must not be placed closer than 0.2 m from the work 
area. Such objects are: metallic surface of the laboratory bench, steel 
furniture fasteners, tools (tweezers, screwdrivers, scissors, etc.), 
stationery (drawing pins, clips), coins, etc.

2) Sources of strong magnetic field (permanent magnets, 
electromagnets, inductance coils) must not be located closer than 
0.5 m from the work area.

ATTENTION!
PROXIMITY OF FERROMAGNETIC MATERIALS AND 
SOURCES OF THE MAGNETIC FIELD TO THE VISUALIZER 
CAN DISTORT THE IMAGE FORMED BY IT .

ATTENTION!
IF OBJECTS MADE OF FERROMAGNETIC MATERIALS 
GET INTO THE MAGNETIC FIELD OF THE MAGNETIC 
EXCITATION SYSTEM, THE SYSTEM CAN ATTRACT THEM 
ABRUPTLY AND UNEXPECTEDLY . THE ATTRACTED OBJECT 
MAY HIT THE DEVICE AND CAUSE DEVICE DAMAGE .

Put the visualizer on the pad with the sensitive element facing 
downwards. Connect the device to the PC via the USB cable. The LED 
on the visualizer body lights up if the connection between the device 
and the PC is successful. (When activating the device for the first 
time, PC operating system requires installation of the visualizer 
driver. For more details see paragraph 6.2).

Visualizer software installation
The software supplied with Regula 4197 visualizer includes:
1) CADR application,
2) visualizer driver. 
The procedure of software installation is the following:
Insert the installation medium with the visualizer software into the 

disk drive or USB port of the PC. Create a working folder and copy 
the software into it.

Connect the device USB cable to the corresponding port of the PC. 
If the USB connection between the visualizer and the PC is successful, 
the LED indicator on the visualizer body will light up.
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The operating system will detect a new USB device and 
automatically launch the Device Driver Installation Wizard. Set the 
path to the device driver directory manually.

When installation is complete, open the Device Manager window 
to check that a new device «Magneto-optical Visualizer 4197» has 
appeared in the «Forensic Devices» section. Make sure that the 
device is installed correctly (without «?» or «!» marks in the Device 
Manager panel) .

After the driver has been installed, the CADR application is ready 
to be started. You can launch the application by running the file CADR.
EXE in the working folder or by using the application shortcut located 
in any suitable place.

Operation execution
Put an examined document and the visualizer (with the sensitive 

element facing downwards) on the visualizer pad.
To start the CADR application, double click on the application 

shortcut or on the icon of the file CADR.EXE in the folder where the 
application is installed.

In the appeared window of the CADR application, click the button 
of background image input A (Figure 4) .

6.2

Figure 4

An information window with instructions will appear. Follow the 
instructions given: lift Regula 4197 5–10 cm above the examined 
document and press any of the two functional buttons (3 or 4 
(Figure 1)) on the visualizer body. After background image input is 
performed successfully, the information window will disappear.

The process of background image input can be repeated if necessary. 
This need may arise when the resulting image does not satisfy the user 
who assumes that the background image was poorly scanned.
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Put the visualizer on the examined document with the sensitive 
element facing downwards.

Not all documents are printed using magnetic ink. So if there is 
no document with magnetic security features at the initial startup of 
the device, use the test object from the visualizer delivery set to check 
device operation.

See paragraph 6.5 for more information about the purpose and use 
of the test object.

To activate the mode of continuous image input, press the right 
functional button of the visualizer (Figure 1, pos. 3). This mode can 
also be activated by clicking on the button of continuous input B 
(Figure 4). The continuous input window displaying the visualization 
result of the magnetic image on the examined document (Figure 5) 
will appear in the CADR main window. When shifting the visualizer 
along the document surface, the image in the continuous input window 
changes accordingly.

Move the visualizer along the document surface to find images 
printed using magnetic inks.

In the continuous input window, the user can take a single frame 
of the examined image for further processing. For this purpose, place 
the visualizer so that the questioned image fragment takes the desired 
position in the continuous input window. Press the left functional 
button of the visualizer (Figure 1, pos. 4). The image fragment will 
be copied  as a permanent frame into a separate window next to the 
continuous input window. Assess the result and, if necessary, repeat 
the copying procedure.

It is possible to capture several frames which will be displayed in 
separate windows. Afterwards, the images from these frames can be 
processed using the tools of the CADR software (for more information 
about the tools see the file CADR_ENG.DOC from the visualizer software 
set and paragraph 6.4 «Processing the Results»). The obtained results 
can be saved to the PC hard disk in one of the standard graphic 
formats. To do so, select the menu items [File]->[Save] of the CADR 
application .

In the process of device operation, background image input can be 
repeated (if necessary) by clicking on image input button and following 
the instructions described above.

The visualizer supports two image formats — 512×640 pixels and 
1024×1280 pixels. We recommend using the 512×640 format 
(Figure 5).
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Figure 5
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To switch the format, select the menu item [File] -> [Videodriver] -> 
[Video format] (Figure 6).

Figure 6

Background and frame input options
The visualizer can operate in several modes that allow obtaining 

images of different quality. But the modes in which high-quality 
images are captured require more time to form a frame.

The user should select an appropriate mode in accordance with his 
particular tasks.

To select an appropriate mode, right-click on the button of 
background image input A or on the button of single frame input C 
(Figure 7). The window «Mode of frames and background input» will 
appear .

A background image (background) is used in the visualizer to 
improve the quality of the obtained resulting images that the user 
examines in CADR windows. The background is input at the beginning 
of the device operation, as well as in the process of operation if 
necessary.

The background should be input when the magneto-optical 
crystal is not in contact with any magnetic images or other sources 
of magnetic field. A frame (a single frame or series of frames in the 
mode of continuous input) is input when the sensitive element is in 

6.3
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contact with the magnetic image of the examined document. Then 
the program subtracts the background from the frame. As a 
result, in the obtained image, the user can see only the document 
magnetic image against a solid gray background.

Such technology allows filtering possible noises, artifacts and 
brightness irregularities which the initial (background) image formed 
by the magneto-optical crystal may contain.

In the window «Mode of frames and background input», the user 
can select one of three standard modes of background and single 
frame input — «View», «Discovery» and «Research».

Figure 7

View — the visualizer is taken away from the examined document 
(and other possible sources of magnetic field) and a single background 
frame is input. Then the frame of the examined document is input 

A
C
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once. Afterwards, the background is subtracted from this frame. 
This operation mode is the most simple and quick.

Discovery — a background image is input twice. Then the 
arithmetic mean of those two images is used as the background. It 
means that two brightness values of each pixel are summed up and 
divided by two. It helps to reduce the influence of random noises (pixel 
brightness fluctuation) in the magneto-optical channel of the device. 
The frame of the examined document is input twice and averaged. 
Then the average background image is subtracted from the average 
frame image. This mode is slower but it provides resulting images 
that are more sharp and noiseless.

Research — a background image is input eight times and then 
averaged. A frame with magnetic image of the questioned document 
is also input eight times. In addition, the mode of magnetic 
displacement is activated. It means that the device inductor 
generates an additional magnetic field suppressing random single 
pixels irrelevant to the informative image. When the magnetic image 
is input eight times, the inductor generates N-S polarized magnetic 
field four times and four times the opposite — S-N polarized magnetic 
field. The frames obtained by this technique are averaged (eight 
brightness values for each pixel are summed up and divided by eight). 
Then the averaged background is subtracted from the averaged 
frame. This mode takes the longest time and produces the resulting 
image of the highest quality. But it can also suppress minor useful 
details and pixels of the examined image.

Parameters of the selected mode are displayed in the «Mode 
of background input» and «Mode of single frames input» sections. 
The user can customize these parameters if necessary.

To restore the default settings, click on the corresponding 
«Default» button.

Processing the results
The CADR software provides the user with a wide range of tools 

for processing visualized magnetic images. More information about 
the application tools is given in the User’s Guide to the software.

Below we give the description of several functions of the CADR 
software: «Deviation from middle» and «Magnetization» that are 
most commonly used for processing magnetic images in security 
documents.

«Deviation from middle» function
To activate the «Deviation from middle» function, scan a document 

which contains a magnetic image or open one of the previously 
saved images from the menu [File] - > [Read]. Then right-click 

6.4
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on the F button (Figure 8) located in the lower row of the toolbar. 
The «Deviation from middle» window will open.

If the mentioned button does not appear on the toolbar when 
starting the CADR application for the first time, double click on 
the free space of the toolbar lower row with the left mouse button 
while holding the <Ctrl> key. In the appeared «Customize Toolbar» 
window, it is possible to add the required button to the toolbar.

The «Deviation from middle» function calculates the average value 
of pixel brightness values in the processed monochrome bitmap. 
«Plus» or «minus» deviation from this value by some quantity is 
considered to be a dead zone. The pixel brightness values lying within 
the dead zone range are replaced by the average value. Brightness 
values exceeding the upper limit value of the dead zone are increased. 
Brightness values being less than the lower limit value are lowered.

Figure 8

F
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Here is the list of image processing parameters and their purpose:
Width of the dead zone — specifies the range of the pixel 

brightness deviation from the average value. Within this range, 
brightness values are adjusted to the average value.

Shift of the dead zone — allows shifting the dead zone by some 
positive or negative value relative to the brightness average value.

Multiplier — determines the degree of brightness change for the 
pixels with brightness values beyond the limits of the dead zone.

Smooth (remove noise) — reduces the contrast of pixels with 
random brightness deviation against the image general background.

Adding deviation to the image —  if this option is not checked,  
the average brightness value is subtracted from all values of the 
image pixel brightness. The following options are available in this 
mode:

  Negative — converts a processed image to a negative. 
  Binding to a middle level of the image — adjustment 
of the image pixel brightness relative to the average 
brightness value.
  Binding to an image envelope — correction of the image 
pixel brightness for uneven illumination distribution over 
the input frame.
  Envelope smoothing — the parameter of correction for 
uneven illumination distribution over the input frame.

View — if this checkbox is checked, all changes in image processing 
parameters will immediately cause corresponding image changes.

OK — exit from the «Deviation from middle» window saving 
the specified parameters of image processing. In this case, the image 
changes are not saved. The image preserves the parameters set 
before opening the «Deviation from middle» window.

Cancel — exit from the «Deviation from middle» function without 
saving the specified parameters of image processing. The image 
preserves the parameters set before opening the «Deviation from 
middle» window.

Apply — exit from the «Deviation from middle» function saving 
the specified image processing parameters. In this case, the image 
changes are applied. 

The «Deviation from middle» function can also be activated by 
double clicking the left mouse button on the button C (Figure 8) . 
In this case, the function is executed without displaying the image 
processing parameters which correspond to the latest saved.
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Assessment of magnetic parameters
The «Magnetic measurements» function of the CADR software is 

intended for assessing magnetic parameters of the materials used 
to produce document security features and for comparing these 
parameters in examined documents and in templates (certainly 
authentic documents) for a further conclusion about a probable 
forgery.

The results of the «Magnetic measurements» function execution 
are the following: the histogram of the normal component of 
the magnetic induction vector Bn (mT) for a single image frame, 
the value of the modulus of the magnetic flux Фn (nWb) through 
the frame area, the distance d between histograms of the examined 
document and the template. Comparison of the measured parameters 
(Bn, Фn, d) allows carrying out document authenticity verification and 
assessing wear or damage rate of the magnetic image.

The normal component of the magnetic induction vector Bn is a 
component of the vector of the magnetic induction generated by the 
material of the magnetic image located in the visualizer frame area. 
This component is perpendicular to the frame surface.

Magnetic induction Bn is assessed for each pixel of the examined 
image according to the compensation scheme. This technology is 
used in the inductor that is a graduated source of the magnetic field.

The inductor generates 32 different levels of the magnetic 
displacement field that partially equalizes the residual magnetization 
field of the examined image. The CADR software captures 32 frames 
and counts the number of changed image pixels corresponding to 
each level of the compensating magnetic field.

This is the way brightness distribution in 32 image frames is formed. 
On the one hand, it is connected with the strength of the residual 
magnetization field generated by the magnetic material of the ink. 
On the other hand, it is connected with the level of the compensating 
magnetic field of the inductor.

The histogram of the normal component of the magnetic induction 
is built based on the brightness distribution in the coordinates lg(n)-Bn 
(Figure 9d). Here n is the number of pixels in the image, Bn — magnetic 
induction.

The induction of the magnetic stray field is assessed in the range from 
the sensitivity threshold of the magneto-optical crystal (≈ 0.1-0.2  mT) 
to the maximum compensation field of the inductor (≈ 2.8 mT).

The magnetic flux Фn is calculated according to the histogram Bn  
and the known area of the visualized zone.



18

The distance d between the two histograms is calculated as 
follows: each histogram column is compared with the corresponding 
column of the other histogram, and the modulus of their difference is 
calculated. Then all moduli are summed up for all columns. This sum 
is the d parameter of the two compared histograms. It is a similarity 
parameter. The smaller d is, the more similar the histograms are and 
the higher is the probability that the two compared documents are 
printed with the same ink using the same technology.

For different types of documents and banknotes the value of 
the distance d, which distinguishes an original document from a 
forged document, may differ. An expert is to determine these values 
experimentally by accumulating experience and experimental data.

* The distinctive physical feature of the magnetic measurement process 
is a significant dependence of its results on the temperature at which 
the measurement is taken. In particular, the magnetic properties of the examined 
materials exhibit different degrees of dependence on the temperature.

In this connection, it is necessary to take measurements in the same 
narrow temperature range in order to improve the accuracy when comparing 
the obtained results.

Therefore, when executing the «Magnetic measurements» function, 
the ambient temperature should meet the requirements for the mode of 
magnetic parameter measurements (see section 7 «Technical Specifications»).

To call the «Magnetic measurements» function, left-click on 
the E button (Figure 9a) or left-click in the menu [Modules] -> 
[«MagMouse / Regula 4197»] -> [Magnetic measurements] (Figure 9b).

Before running the «Magnetic measurements» function, input a 
background image as described in paragraph 6.3 (Button A, Figure 7). 
During further work with this function, repeat the background image 
input for approximately every fifth function execution.

To access the options of the «Magnetic Measurements» function, 
right-click on the E button .

A window with the following options will appear (Figure 9c): 
«Threshold of histogram distance (d)», «Decreasing compensating field 
(recommended)», «Increasing compensating field» and «Improved 
precision of graph scales».

It is recommended to set the initial value of d in the range  
d = 15-20 and set the decreasing compensating field.

The option «Improved precision of graph scales» changes the 
number of digits in scale numbers of the magnetic induction histogram 
which is formed as a result of the magnetic measurements. If this 
option is enabled, the number of digits after the decimal point on 
the lg(n) scale is 2, on the Bn scale is 3. If the option is not selected, 
the number of digits after the decimal point is 1 and 2, respectively.
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Figure 9a

Figure 9b
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To begin the procedure of magnetic parameter assessment, 
activate the mode of continuous image input (by pressing the right 
button 3 of the visualizer (Figure 1) or by left-clicking the B button 
in the CADR application window (Figure 4)) and select the required 
fragment of the examined document by moving the visualizer.

Stop moving the visualizer. The device should stand still for about 
30 s while the measurements are taken.

Then left-click on the E button (Figure 9a) or in the menu  
[Modules] ->[«MagMouse / Regula 4197»] -> [Magnetic measurements] 
to call the «Magnetic Measurements» function (Figure 9b).

As the «Magnetic Measurements» function starts, two windows 
open. The first window is intended for summation of 32 image frames 
with different levels of magnetic displacement. The second window 
shows a graph — the histogram Bn. The green LED blinking on 
the visualizer and a specific sound indicate that the device operates 
in the mode of taking magnetic measurements.

It is possible to input up to 3 graphs (Figure 9d) into the same 
histogram Bn window.

Figure 9d shows the histograms Bn for two authentic banknotes 
and a forged one. The distance between the histograms Bn for the pair 
of authentic banknotes is d=4. It is d = 89-91 for the pair «authentic-
forged» (excess of the determined threshold d=15 is marked with a 
rectangular frame) .

Figure 9c
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Figure 9d

ATTENTION! 
TO ACHIEVE ACCURATE COMPARATIVE ASSESSMENT 
OF MAGNETIC PARAMETERS, MAKE SURE THE CONTROL 
AREAS OF EXAMINED AND REFERENCE DOCUMENTS 
COINCIDE . WHEN CHOOSING THE CONTROL AREA, 
THE AREAS WITH HIGHER PRINT DENSITY AND 
THICKER INK LAYER ARE PREFERABLE .

When examining crumpled documents and banknotes, press 
the visualizer manually to provide close magnetic contact between 
the document and the visualizer.

Magnetic parameters can be assessed with the installed magnetic 
excitation system (Figure 1) for all types of magnetic materials and 
with the removed magnetic excitation system for magnetically hard 
materials. 

Ferromagnetic materials (including magnetic dust on the visualizer, 
the examined object and the pad) and the sources of the magnetic 
field located close to the device, may distort the measurement results.
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ATTENTION!
FERROMAGNETIC MATERIALS AND SOURCES OF 
MAGNETIC FIELD LOCATED CLOSE TO THE DEVICE MAY 
DISTORT THE IMAGE FORMED BY THE VISUALIZER AND 
THE RESULTS OF THE MAGNETIC MEASUREMENTS .
BEFORE STARTING DEVICE OPERATION MAKE SURE 
THAT THE REQUIREMENTS OF PARAGRAPH 6.1 ARE 
OBSERVED .

Magnetic remeasurements
Function purpose and execution
The «Magnetic remeasurements» function allows saving the results 

of the «Magnetic measurements» function and reproduce these results.
To carry out magnetic remeasurements of any frame of 

the document, first perform the function of magnetic measurements 
for this frame.

After the magnetic measurements are taken, the frame image 
will slightly change. It will look a little smoother and more blurred 
(Figure 10a). This modified image contains information about 
the results of measuring its magnetic parameters.

This image can be saved (see paragraph A) in order to run the 
remeasurement procedure later after opening this image from the disk. 
It is also possible to perform the procedure of magnetic remeasurements 
with the given modified frame (see paragraph B) without saving it.

A. To save the image, which contains magnetic measurement 
data, activate the window with this image by clicking on it once. Then 
select in the CADR menu [File] -> [Save].

B. To perform the «Magnetic remeasurements» function:
  activate the window with this image by clicking on it once.
  perform the «Magnetic remeasurements» function from 
the CADR menu: [Modules] -> [MagMouse/Regula 4197] -> 
[Magnetic remeasurements].

As a result of «Magnetic remeasurements» function execution 
a window appears. It contains a histogram of the normal component 
of the magnetic induction Bn for the image frame and the calculated 
value of the modulus of the magnetic flux Фn in the image area 
(Figure 10b).

The function of magnetic remeasurements can be performed  
multiple times for the same image.
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Figure 10a

Figure 10b
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Evaluation of magnetic parameters for a fragment of the  
image frame 

The «Magnetic remeasurements» function allows assessing 
magnetic parameters not only for the whole image frame but also 
for a fragment of it .

To execute the «Magnetic remeasurements» function for an image 
fragment, select the required area of a modified image by holding 
the <Alt> key and moving the mouse cursor (with the left button 
pressed) in the window. The blinking frame will appear in the window 
(Figure 10c) .

Figure 10c

The frame shows a part of the whole image frame for which magnetic 
parameters will be measured. Its size and position can be changed by 
moving its corners with the mouse cursor. To specify exact settings of 
the frame, select in the CADR menu [Edit] -> [Fragment] (Figure 10d).

In the «Fragment» window, the four graphic windows display 
the location of each of the four frame corners. It is possible to move each 
corner of the frame by clicking the mouse in the corresponding window.
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Figure 10d

«X1,Y1» and «X2,Y2» are the coordinates of the upper left and the 
lower right corners of the frame. «Width» and «Height» are the width 
and height of the frame in pixels. «Aspect ratio» can be selected from 
the following: «Any», «1:1», «4:3», «3:4».

When the required position and dimensions of the frame are set, 
activate the function «Magnetic remeasurements» as it was described 
above ([Modules] -> [MagMouse/ Regula 4197] -> [Magnetic 
remeasurements]). The window will appear showing the histogram 
of the normal component of the magnetic induction Bn (tesla) for 
the image fragment selected with the frame and the calculated value 
of the modulus of the magnetic flux Фn (weber) in this fragment. 

This operation can be also performed in a different order. Run 
the function «Magnetic measurements» first. Then, in the window 
of the image frame, form a rectangular frame (Figure 10c) by 
holding the <Alt> key and moving the mouse cursor (with the left 
button pressed) over the image. The data in the window of magnetic 
measurement results change dynamically depending on the position 
and dimensions of the frame.

Application of the «Magnetic remeasurements» function to 
multiple frames

The «Magnetic remeasurements» function allows getting up to 
three measurement results in one window. These results correspond 
to three separate image frames. As a result, it becomes possible to 
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compare the results of different measurements performed on different 
documents at different times.

First of all, in the CADR window open three images for which 
the magnetic measurements were taken. These could be the images: 
1) processed and saved on a computer disk or 2) obtained as a result 
of three successive direct measurements or 3) any combination of 
previously saved and recently processed images. 

Then activate one of these image windows by clicking on it once. 
Execute the «Magnetic remeasurements» function for it. Afterwards 
activate the second image window and execute the «Magnetic 
remeasurements» function. And in the end the same procedure 
should be repeated for the third image window.

As a result, three histograms of the normal component of 
the magnetic induction Bn and three values of the modulus of 
the magnetic flux Фn for image frames of three different documents 
as well as distances d between the histograms Bn will appear in one 
window (Figure 10e).

Figure 10e
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When the data obtained from several documents is represented 
in one window, it allows carrying out comparative analysis of these 
documents. 

Assessment of magnetic parameters for a fragment of the image 
frame (as it is described above) can be performed for each image 
frame. In order to do this, form a rectangular frame in each image 
frame holding the <Alt> key and moving the mouse cursor (with 
the left button pressed). Magnetic parameters are measured for 
the areas selected within each frame.

Numerical representation of measurement results
The data of the histograms of the magnetic induction Bn normal 

component can be represented not only in graphical, but also in 
numerical form as columns of numbers. 

To change the format of data presentation, activate the window 
«Magnetic induction histogram» by clicking on it once with the mouse 
cursor. Then press the key combination <Ctrl+C> or select the item 
[Edit] -> [Copy] in the CADR menu. As a result, the numerical data 
concealed in the «Magnetic induction histogram» window is copied to 
the computer clipboard.

Then open a text file of either Microsoft Word or Notepad 
(OS Windows). Paste the data from the clipboard into this file. 
The data consists of columns of numbers. The number of columns 
can vary from 2 to 5 depending on the number of histograms built in 
the «Magnetic induction histogram» window.

The first column contains the values of the magnetic induction Bn 
normal component in tesla. The rest of the columns contain lg(n) — 
the logarithms of numbers of pixels. The latter correspond to the values 
of the magnetic induction Bn given in the first column. The columns 
correspond (from left to right) to the red (R), a green (G) and blue 
(B) diagram.

«Approximation» function
The results of the «Magnetic measurements» function may 

be affected by the factors which decrease the comparability of 
measurement results obtained from different documents or different 
fragments of the same document. These factors can be, for example, 
image background noises, different magnetic print density of the 
compared images (the number of magnetic image lines per unit 
area of a frame), as well as preliminary biased magnetization in 
the magnetic images.

The impact of such factors can distort the results of the comparison 
between an examined document and a template.

Therefore, the «Approximation» function was added to the CADR 
software.



28

When the «Approximation» function is executed, the data of the 
histogram Bn are additionally processed. An approximating curve is built 
based on the processing results. The curve has the following properties:

1) The approximating curve is in the form of a quadratic parabola.
2) When the approximating curve is being built, the pixels 

appearing because of background noise (i. e. random pixels 
that arise in the frame having no magnetic image) are excluded 
from the array of the processed pixels.

3) *When the approximating curve is being built, special 
corrections are made. They make the shape and position of 
the curve independent of the number of magnetic image pixels 
that got into the processed frame. It means that the shape and 
position of the curve do not depend on how densely the frame 
is filled with the lines of the magnetic image.

Such corrections allow comparing the characteristics of document 
magnetic material by different content of compared frames.

4) *When the approximating curve is being built, some other 
corrections are made. They make it possible to compensate possible 
displacement of image magnetization towards S or N polarity.

When the «Approximation» function is executed, the distance d 
between the histograms Bn is recalculated taking into account all 
the corrections described above.

To call the «Approximation» function, first left-click on the appropriate 
«Magnetic induction histogram» window containing data which are to 
be subjected to the approximating procedure.

Then select in the menu [Modules] -> [MagMouse/ Regula 4197] -> 
[Approximation] (Figure 10f).

* Making the corrections described in items 3) and 4) is called 
NORMALIZATION of the approximating curve.

Figure 10f
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To execute the «Approximation» function with NORMALIZATION 
(see items 3) and 4) above), select it in the application menu holding 
the <Shift> key at the same time.

Figure 10g shows initial histograms Bn (the upper window) and 
approximated histograms (the lower window).

Figure 10g

«Magnetization» function
The CADR application has a «Magnetization» function which allows 

comparing the levels of magnetization in a questioned document and 
in a template. The «Magnetization» function transforms an image 
printed with magnetic ink on the document surface to the colour map 
which displays the level of relative magnetization of image fragments. 
Comparison of the colour maps of an examined document and a 
reference document allows making a conclusion about document 
authenticity and about the degree of magnetic image deterioration 
or damage.
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Source data for colour map calculation is the distribution of 
magneto-optical image brightness. The brightness distribution is 
connected with the strength of the magnetic stray field produced by 
the magnetic ink. The strength of the magnetic stray field is assessed 
in the range from the sensitivity threshold of the magneto-optical 
crystal to the strength of complete remagnetization.

To access the tools of the «Magnetization» function, right-click 
on the D button (Figure 11a) while the window with a magneto-
optical image is active.

Figure 11a

Figure 11b

Another way to run the «Magnetization» function is to right-
click the menu item [Modules] -> [«MagMouse/Regula 4197»] -> 
[Magnetization] (Figure 11b).

In the appeared window the following options are available: 
«Contouring», «Сontours overlay» and «Painting by rainbow».
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When «Painting by rainbow» is selected, the colour map is formed 
by filling in the zones having equal magnetization levels with the same 
solid colour (Figure 11c). In this case, the initial magneto-optical 
image is the background of the map.

Figure 11c
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Figure 11d

When the «Сontours overlay» option is selected, the colour map 
is formed by contouring the zones having equal magnetization levels 
with lines of the same colour (Figure 11d). In this case, the initial 
magneto-optical image is the background of the map.

When the «Contouring» option is selected, the colour map is 
formed by contouring the zones having equal magnetization levels 
with lines of the same colour (Figure 11e). In this case, the magneto-
optical background image is replaced by a black background.
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Figure 11e

The parameter «Zone size» defines the size of the minimal area in 
which the magnetization level is averaged, and the area is transformed 
into a coloured spot of the corresponding colour.

It is also possible to execute the «Magnetization» function 
by left-clicking on the D button or through the menu 
[Modules] ->[«MagMouse/Regula 4197»] ->[Magnetization]. In this 
case the «Magnetization» window does not appear. The function is 
executed with the parameters set up earlier.
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Test objects
Test object 4 (universal)
Test object 4 (universal) (Figure 12a) is intended for checking 

visualizer operation in case there are no other objects with magnetic 
printing. Novice users are to use this test object to gain initial practical 
experience in operating the device.

Set up background and frame input parameters (see paragraph 6.3) 
before using test object 4 (universal) for examination. In the window 
«Mode of frames and background input», select the «Discovery» mode. 
In this mode the parameters «Multiple input with accumulation» and 
«Number of accumulation: 2» are set automatically for the mode of 
background input and the mode of single frame input (see Figure 12b).

Different areas of test object 4 are used to control different aspects 
of visualizer operation.

Area A — control of display uniformity across the field of view for 
the grid of intersecting lines; control of the contact flatness between 
the visualizer sensor and examined object surface.

Area B — control of the geometric distortions of the visualizer 
optical system. 

Area C — control of  the centring and size of the visualizer field 
of view.

Area D — control of microtext legibility.

6.5
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Figure 12a

А B

C D

Not a test-object.
The test-object is enclosed separately.

Test-object № 4 (universal)  
for Regula 4197 and Regula 7701
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Operation completion
Close the CADR application.
Disconnect the visualizer’s USB cable from the computer.

Maintenance

ATTENTION!
THE SENSITIVE ELEMENT SURFACE (FIGURE 2) 
IS VERY SENSITIVE TO SCRATCHING AND ERASING . AT 
THE SAME TIME, SOILING OF THIS SURFACE LOWERS 
THE IMAGE QUALITY. AVOID SOILING THE SENSITIVE 
ELEMENT .

Clean the sensitive element if necessary, especially when dirt 
prevents the device from normal functioning.

Figure 12b

6.6

6.7
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It is recommended to get rid of dust by blowing it off or flicking it 
off with a soft brush.

Remove sticky dirt and grease stains carefully with a cotton 
pad slightly moistened with some optics cleaning solution. If such 
cleansers are not at hand, use rectified alcohol. The cotton pad should 
be damp, but not dripping to prevent excess liquid from getting inside 
the device. After cleaning the sensitive element using liquids, wait 
for 3–5 minutes before turning the visualizer on. It will guarantee 
evaporation of the cleaning liquid.

Keep the visualizer pad clean. Avoid dust gathering on its surface. 
Wipe the surface of the pad regularly with the same cleaning solution 
that is used for the sensitive element. Wait until the pad surface is 
completely dry before starting to work with the visualizer.

To prevent dirt gathering on the device and the pad when they are 
not used, keep them in a clean plastic bag.
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TECHNICAL SPECIFICATIONS

Parameters  
and Specifications Value Notes

Field of view, mm, min 14×18

Image frame format, pxl 1024×1280,
512×640

Spatial resolution of the image 
optical input system, mkm

– for 1024×1280 image frame
– for 512×640 image frame 

14
28

Ambient temperature range 
recommended for device operation:

– for magnetic parameter 
measurements*, °С;
– for other operations, °С.

(25±1) °С
(25±10) °C

* — see «Assessment 
of magnetic parameters» 
and «Magnetic 
remeasurements» 
in paragraph 6.4 
«Processing the results». 
Before performing the 
operation, the device 
should be warmed up 
for at least 15 min.

System requirements OS Windows XP
OS Windows 7
OS Windows 8
OS Windows 10

PC connection interface USB 2 .0

Dimensions, mm 59×113×50

Weight, g 490

TRANSPORTATION AND STORAGE
The visualizer is transported and stored in the manufacturer’s 

packaging. Protect the packaged device from hits and vibrations.
The device contains magnetized material packed in accordance 

with the requirements of ICAO Doc 9284 AN/905. The device is 
allowed for transportation by passenger aircraft.

CLIMATIC CONDITIONS OF STORAGE  
AND TRANSPORTATION

Air temperature from +5 to +40 ˚С

Relative air humidity up to 80 % at the temperature of 
+15 ˚C

Atmospheric pressure 100±4 kPa (750±30 mm Hg)

7
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ACCEPTANCE CERTIFICATE
Magneto-optical visualizer "Regula" 4197
Serial number _______________ is produced and accepted

in accordance with obligatory requirements of state standards, 
current technical documentation and considered serviceable.

Responsible for acceptance ____________________
_________________         _________________
      (signature)                  (first and last name)

_________________
(year, month, date)

Seal:

Manufacturer:  JV RIODIN 
Ukraine, 01133, Kiev, Leonid Pervomaisky street, 9a-26,
Phone/Fax: + 38 044 246 4164, + 38 044 288 0549,
E-mail: riodin.kiev@gmail.com

Address for mailing claims with regard to the quality of the device:
29 Kozlova Lane, Minsk 220037, Republic of Belarus
Tel. +375 17 224 66 44, Fax +375 17 318 95 73
E-mail: support@regulaforensics.com
Web: www.regulaforensics.com

SALE CERTIFICATE
Magneto-optical visualizer "Regula" 4197

№ ___________________

          (serial number)

Seal:
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Ukraine, 01133, Kiev, Leonid Pervomaisky street, 9a-26,
Phone/Fax: + 38 044 246 4164, + 38 044 288 0549,
E-mail: riodin.kiev@gmail.com


